
Tutorial Software de Demostración Doors™

1.0 Introducción a Doors

El programa Doors es un software que nos permite configurar y manejar un sistema de control de acceso
usando los controladores de Keri System PXL-250 y la tarjeta satélite SB-293. Doors es un programa
completamente funcional que trabaja en plataforma de Windows™ y que hace uso completo de todas las
características populares de Windows, tales como cambiar el tamaño y relocalizar las ventanas de trabajo,
múltiples ventanas que se abren simultáneamente, operación de fondo, y operación "en tiempo real". Doors
funciona bajo Windows™ 95, Windows™ 98, Windows™ 2000, Windows™ ME, Windows™ NT 4.0, y
Windows™ XP. 

Doors provee al operador una interfaz de fácil uso para definir parámetros del sistema, archivos de manejo
de las tarjetas, archivos de transacciones, fijando funciones que miden el tiempo, y preparando informes.
Para los operadores que están familiarizados con programas de hoja de cálculos (tales como Microsoft
Excel™), muchas operaciones se pueden realizar en formato de este tipo de hojas, como clasificación
simple, selección de bloques, y copia de bloques, funcionan perfectamente. Una ayuda proporciona al
operador un procedimiento, paso a paso, para crear los Grupos de Acceso  (un método de asociar puertas de
acceso a períodos de operación). Un extenso archivo de ayuda en línea, pone una completa guía al alcance
del operador.

No es necesaria una PC dedicada para correr Doors. La PC es solamente necesaria para entrar y actualizar
la información a los controladores, descargar la información de los Controladores o para la supervisión
(monitoreo) en tiempo real de la red. Doors utiliza un protocolo de comunicaciones propietario que
comprueba automáticamente todos los controladores en la red y los configura según el hardware
conectado, simplificando grandemente el proceso de puesta a punto del sistema. Este protocolo de
comunicaciones propietario reduce al mínimo las averías generales de Windows™ (GPFs) y los fallos del
sistema. 

Doors es capaz de manejar hasta 256 puertas en un solo sitio vía conexión directa tipo serial, vía un
módem, o TCP/IP usando LAN-50, y es capaz de manejar hasta 255 sitios remotos, cada uno vía módem o
TCP/IP. El control de múltiples sitios remotos ofrece marcado automático, inscripción de tarjetas de forma
global o de un sitio especifico, reporte de eventos global y específico a un sitio, y transferencias directas
automáticas configurables de acontecimientos de eventos de los controladores. 

1.1 Características de Doors:
• Hasta 32 operadores de sistema, cada uno con contraseña de protección y privilegios configurables.
• Hasta 32 zonas de tiempo (Horarios) cada una con 4 intervalos con inicio / término
• Hasta 3 grupos para días Feriados, cada uno con hasta 32 días de fiesta definibles
• Un número virtualmente ilimitado de Grupos de Acceso (sujeto a espacio disponible en el disco duro)
• Hasta 6 campos de texto adicionales, sorteables para información adicional del usuario de tarjeta

además del Nombre, del Número de Tarjeta, del Grupo de Acceso y del Departamento
• Hasta 255 sitios remotos.
• Hasta 128 controladores por sitio
• Hasta 128 puertas (una por controlador) o hasta 256 puertas (dos por controlador) si usa el tablero

satélite opcional SB-293 con cada controlador. 
• Virtualmente número ilimitado de tarjetas y usuarios.
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Tutorial Software de Demostración Doors™

•  Cada controlador puede tener un único grupo de usuarios, pero un control individualmente puede tener
el siguiente número de tarjetas.
− Con memoria RAM Standard instalada - 10,920 tarjetas

− Con memoria RAM Extendida instalada - 65,535 tarjetas
•  Cada controlador puede almacenar hasta  3,640 eventos. Estos eventos pueden ser transferidos al

software de Doors  para almacenar en el computador principal.

1.2 Requerimientos del Computador Principal.
Para la adecuada operación del software de Doors, el computador principal debe tener los siguientes
requerimientos.
• Computador PC compatible con procesador PentiumTM-90 o de mayor velocidad
• Mínimo de 16 MB de memoria RAM
• SVGA monitor color con  tarjeta gráfica SVGA  (800 x 600 resolución mínima)
• CD-ROM, y floppy disk drive de 3.5, teclado y mouse
• 50 MB de espacio libre en el disco duro
• Puerto de comunicación serial COM con 16,550 UART para conexión a través de MODEM externo o

por conexión directa vía RS-232, o un MODEM interno 9,600 baud (o más rápido)
• Uno de los siguientes sistemas operativos:

− Windows™ 95
− Windows™ 98
− Windows™ 2000
− Windows™ ME
− Windows™ NT 4.0
− Windows™ XP

1.3 Requerimientos para Carnetización 
Para la adecuada operación de Doors con la aplicación de Carnetización , son necesarios los siguientes
requerimientos. Estos requerimientos superan el requerimiento standard para Doors PC mencionados
arriba.

• Windows™ 95, Windows™ 98, Windows™ 2000, Windows™ ME, o Windows™ NT 4.0 sistemas
operativos.

• La tarjeta gráfica SVGA debe ser capaz de mostrar 65K colores para asegurar que las imágenes de foto
sean adecuadamente mostradas.

• Entre 100 MB y 1GB de espacio en el disco duro es necesario, dependiendo del número de usuarios
para los cuales el sistema proporcionará las credenciales.

NOTA: El driver TWAIN que controla la comunicación entre los scanners o cámaras digitales y el
software de carnetización  no es compatible con Windows NT 4.0. Métodos alternativos para transferencia
de imagen digital son necesarios para estas cámaras.
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Tutorial Software de Demostración Doors™

2.0 Instalando el Software de Demostración 
Realice los siguientes pasos para instalar el software de demostración Doors  en su computadora.

1.  Coloque el CD de Doors en el CD-ROM drive.
2.  Use Windows EXPLORER para mostrar el contenido del CD, si este no arranca en forma automática. 
3.  Navegue a través del CD, localice y haga doble click, en el programa Setup.exe.
4.  El programa de instalación automáticamente empezará a preparar el proceso de instalación del

software. Cuando el programa de Instalación automática esté listo, una ventana de Bienvenida

aparecerá haga click en el botón de  para iniciar el proceso de instalación del software.
5.  La ventana de Selección del producto aparecerá. Click sobre la línea de Doors  y luego click en

 para iniciar el proceso de instalación de Doors.
6.  La ventana de selección de Tipo de Instalación aparecerá. Esta ventana de Tipo de Instalación le

permite elegir entre Instalación de demostración, nueva Instalación o Actualización de Doors .
7.  Una vez seleccionado el tipo de Instalación, la ventana  de Aceptación de Licencia del Software

aparecerá, use la barra  sobre el lado derecho para navegar hacia arriba y hacia abajo  para revisar el
acuerdo de Licencia proporcionado, después de leer este acuerdo haga  click en el botón de  .

8.  La ventana de Readme.txt aparecerá. Esta ventana le da la oportunidad de leer él archivo de Readme
que se encuentra en el disco de instalación, este archivo  tiene las notas de  lanzamiento para la versión
de Doors y la información concerniente al proceso de instalación. Keri Systems recomienda
fuertemente la lectura de este archivo. La instalación de fábrica está puesta para ver el archivo. Si Ud.
elige no ver el archivo de Readme.txt , haga click en el botón de Not now. Cuando esté listo, haga click
en el botón   . Si elige ver el archivo de Readme.txt una nueva ventana aparecerá con el texto.
Vea e imprima esta información como lo desee, cuando finalice, haga click en el cuadro  en la
esquina superior derecha de la ventana de información.

9.  La ventana de selección de idioma aparecerá. El inglés es la selección por defecto para el programa
Doors. Si su aplicación requiere una traducción a idioma extranjero, haga click sobre el idioma
deseado, luego haga  click en  .

10. La ventana de selección para la característica de carnetización aparecerá. Para una instalación típica
de Doors, haga click en el botón de NO y luego en  .

11. La ventana de selección del Fólder donde se instalará el software aparecerá, en esta ventana Ud.
Identifica el fólder donde desea que el software de Doors sea instalado. Para muchas aplicaciones el
fólder por defecto es el mejor lugar para instalar el software. Si un directorio diferente va ha ser usado,
haga click  navegue hasta el directorio en el cual desea instalar el software, y luego haga click
en  . Cuando esté listo, click  .

12. El programa de Instalación mostrará una barra de Progreso en la copia de los archivos.  Cuando la
instalación ha sido completada se mostrará una ventana de Instalación (Setup) Completo.

13. Click en  para salir de la ventana de instalación. Un ícono de shortcut aparecerá en el desktop

del computador . Para empezar el programa de Doors , simplemente haga doble-click sobre
este ícono.
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Tutorial Software de Demostración Doors™

3.0 Inicializando el Software de Demostración 
El software de demostración está diseñado para mostrar las características del Programa Doors . Este usa
un programa de simulación que genera todos los tipos de entrada de datos y operaciones del programa
asociadas con una instalación típica de Doors. Muchas de las operaciones de Doors  pueden ser realizadas,
y el simulador del programa proporciona la respuesta adecuada.

Haga doble-click sobre el ícono de Doors ubicado en el Desktop de Windows para iniciar la demostración.
Una ventana de Validación aparecerá solicitándole nombre y contraseña.

Figure 1: Ventana deValidación

• Click en Nombrey escriba Keri.
• Click en Contraseña y escriba nuevamente Keri. Cuando escriba la contraseña los caracteres que

escribe aparecerán como ****. Esta es una característica de seguridad, para que nadie pueda mirar
sobre su hombro y conocer su contraseña cuando la esté ingresando.

• Ahora click en el botón de OK y habrá entrado al programa de demostración de Doors .

NOTA: El nombre y la contraseña son sensitivos a mayúsculas y minúsculas. Debe escribir  "Keri"
(mayúscula "K",minúscula "eri")para entrar al programa.
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4.0 Características Principales
La siguiente información resume las principales características del programa Doors. Estas son presentadas
en el “típico” orden en el que un operador puede usarlo para crear una red de control de acceso.

4.1 Barra de Herramientas
La barra de herramientas, tiene un conjunto de botones que proporcionan un acceso rápido a las
características mas comúnmente usadas en Doors , una pequeña casilla de captación muestra el nombre de
la función.

Figure 2: Barra de Herramientas

4.2 Configuración de Operadores
Click en Configurar  luego seleccione Operadores. La siguiente ventana aparecerá.

Figure 3: Ventana de configuración de Operadores.

El software de Doors  soporta hasta 32 operadores, cada uno con una única contraseña. La ventana de
Operadores, es usada para determinar que puede y que no puede hacer el operador. Operadores pueden ser
asignados para no acceder a ninguna operación (No), operaciones de acceso completo (Sí), de todas o
algunas operaciones, puede haber operadores de solo Lectura (LS) permitiendo el acceso a ver, pero no ha
realizar ninguna operación.
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Tutorial Software de Demostración Doors™

4.3 Configuración de Zonas de Tiempo (Horarios)

Click en Configurar luego seleccione Horarios. O haga click directamente en  La siguiente ventana
aparecerá.

Figure 4: Ventana de configuración de Horarios

Hasta 32 zonas de tiempo (Horarios) pueden ser definidas, cada una con 4 intervalos de inicio y fin.
Hasta  3 Horarios de días feriados pueden ser definidos, cada uno con hasta 32 fechas de días feriados. Un
calendario Pop-Up está disponible para ayudar a ingresar los feriados.

Figure 5: Ventana de configuración de feriados
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Tutorial Software de Demostración Doors™

La ventana de configuración para tiempos de Zona y dias feriados proporciona máxima flexibilidad en la
configuración de horarios y días feriados de acuerdo a la necesidad del cliente. Los horarios permiten al
operador definir los varios períodos de tiempo por dia y periodos de feriados para ser aplicados a los grupos
de acceso, la función de auto-unlock/lock, (con/sin seguro) y operaciones de entrada salida. Doble-click en
las celdas de fecha y aparecerán una pequeñas flechas de ajuste para cambiar las fechas, tanto en horarios
como en feriados. Doble-click nuevamente en la celda de fechas dentro de feriados y un calendario
aparecerá, permitiendo buscar la fecha deseada. O click en la celda y escriba directamente.

NOTA: El programa Doors  usa un reloj de 24-horas. Por ejemplo, 7 A.M. es mostrada /ingresada como
07:00 horas y  7 P.M  es mostrada /ingresada como 19:00 horas.

4.4 Configuración de los Controladores

Click en Configurar  Sistema  o haga click en  el botón  en la barra de herramientas, y luego click
en Controladores. La siguiente ventana aparecerá.

Figure 6: Configuración de Controladores

La configuración de Controladores permite un reconocimiento de todos los controladores en la red del
sistema de Control de Acceso para extraer la información de la configuración de controlador / puerta
usando la característica de  auto configuración. 

Click en el botón de  para iniciar Autoconfiguración y el software de Doors recupera la
información de configuración de todos los controladores. Esta información es registrada en la base de datos
de Doors automáticamente, haciendo el proceso de configuración de la red mucho más fácil. Una vez
que todos los controladores han sido registrados en la base de datos, el operador puede configurar los
siguientes parámetros:

D
ocum

ento de R
eferencia

D
oors



Tutorial Software de Demostración Doors™

• Parámetros de Habilitar Llamada - permite al controlador contactar al computador principal PC y
recibir la información de los eventos, para asegurar que la información no se pierda cuando el buffer
del controlador se llene o alcance el por ciento asignado.

• Habilitar / Deshabilitar Antipassback - anti passback proporciona una manera de que en un área segura
evitar que un usuario use su tarjeta para ingresar a esta área  y luego este le pase la tarjeta a otra
persona  para entrar a la misma área. Esto se logra en cada controlador y después de que la opción de
Antipassback Local es activado bajo Opciones de Sistema.

• Colocar el tipo de dispositivo para lectores WiegandTM - proporciona información al controlador
cuando se usan lectoras compatibles  Wiegand.

4.5 Configuración de Puertas

Click en Configurar > Sistema o directamente click en el botón  , y luego click en Puertas. La
siguiente ventana es un ejemplo de la ventana de configuración después de que la información ha sido
incorporada por el operador.

Figure 7: Ventana de Configuración Puertas

La configuración de puertas permite al operador definir la configuración y los parámetros de operación para
todas las  puertas / controladores en el sistema de control de acceso. Estas características incluyen lo
siguiente:

• Nombre de Puerta – Asigna un nombre descriptivo para hacer más fácil el leer los reportes de eventos
• Clase de Puerta – Asigna categorías de puerta
• Tiempo Sin Seguro – Coloca una cantidad de tiempo en que la puerta estará sin seguro para permitir el

ingreso.
• Tiempo De Apertura – Determina el tiempo que una puerta puede ser mantenida abierta hasta que una

alarma es generada
• Con/Sin Seguro por Horario – Determina horarios a ser aplicados a una puerta para que

automáticamente esté con/sin seguro
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Tutorial Software de Demostración Doors™

• Primera Persona Admitida – Determina si una puerta se abre automáticamente cuando el horario
con/sin seguro empieza, o si la puerta no será automáticamente abierta por el horario con/sin seguro
hasta que una persona presente una tarjeta válida (asegurándose de que alguien esté en el sitio seguro
antes de que se abra una puerta). 

• Salida de puerta forzada/salida de puerta retenida - Permite la asignación de salidas para ser usadas en
una de las siguientes formas:
1. No-anunciación de alarma en todo
2. Para anunciación combinada de puerta forzada / puerta retenida  en una salida
3. La salida de alarma en el  PXL-250 maneja todas las alarmas para la puerta -A
4. La salida de alarma del SB-293 maneja todas las alarmas para la puerta -B
5. Anunciación separada para alarmas  puerta forzada / puerta retenida  
6. La salida de alarma en el  PXL-250 es la alarma para puerta  -A forzada.
7. La alarma de salida en el  SB-293 es la alarma para puerta -B forzada
8. La salida  4 en el  SB-293 es la alarma para puerta  -A retenida.
9. La salida 3 en el  SB-293 es la alarma para puerta  -B retenida

• RTE Principal / Auxiliar – Permite la asignación de dos entradas de Solicitud de salida separadas:
1. La entrada  RTE principal es típicamente instalada en la puerta de salida y permite al usuario salir

a través de una puerta segura.
2. La entrada RTE auxiliar es típicamente instalada en el escritorio de la Recepcionista o Secretaria,

de tal forma que alguien puede remotamente mediante un botón, permitir la salida a través de una
puerta segura.
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4.6 Configuración de Entradas / Salidas 

Click en Configurar Sistema o  click en  , y luego click en Config E/S . La siguiente ventana
aparecerá.

Figure 8: Ventana de configuración E/S

La configuración de E/S permite al operador definir los puntos de propósito general de Entrada/Salida que
serán usados por el sistema de control de acceso. Si un controlador tiene un SB-293, el programa
automáticamente sabe si el SB-293 está configurado para controlar una Segunda puerta (6 entradas de
propósito general y dos salidas de propósito general) o para función de E/S completas (8 entradas de
propósito general y 4 salidas de propósito general). Las salidas y entradas individuales pueden  ser
asignadas con nombres descriptivos para ayudar a identificar su uso. Las entradas pueden ser
Normalmente Abiertas (N/A) o Normalmente Cerradas (N/C) basadas en el tipo de dispositivo que
manejara la señal de entrada.

Una vez configurados los puntos de E/S , pueden ser enlazados juntos de tal forma que una señal de entrada
pueda activar una salida en el mismo controlador. Por ejemplo, un detector de rotura de vidrio en una
ventana, puede ser asignado como un punto de entrada y una sirena o alarma audible puede ser asignada
como punto de salida. Estos puntos, están enlazados juntos y si la ventana es rota una alarma sonará. El
proceso para enlazar E/S es descrito en la sección  Configuración de Enlaces  en la próxima página.
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4.7 Configuración de Enlaces

Click en Configurar Sistema o click en  , y luego click en Config Enlaces . La siguiente ventana
aparecerá.

Figure 9: Ventana de Configuración de enlaces

La configuración de enlaces, permite al operador definir que entradas locales, serán asignadas a salidas
locales de tal forma que un evento en la entrada provoque una acción de salida. Una vez definidas, las
salidas pueden ser programadas como Intervalo (cuando se activa, la salida permanece activa hasta por  255
segundos), Seguidor (cuando se activa, la salida corresponde el estado de entrada), o Enganchado (cuando
se activa, la salida permanece activa hasta que el operador haga un reset manual). Cada controlador puede
tener hasta 32 enlaces definidos.

Completando el ejemplo dado en la sección anterior (Configuración E/S), el detector de rotura de vidrio ha
sido asignado como punto de entrada. Una alarma audible ha sido asignada como punto de salida. Estos dos
puntos han sido enlazados con el nombre de “Enlace de Alarma”, cuando se rompa el  vidrio sonará la
alarma, en este ejemplo la alarma es enganchada hasta que se apague manualmente y el enlace de E/S
estará activo solo durante el horario de “Alarmas Activas” .
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4.8 Status del Controlador

Click en Configurar sistema o click en  , y luego click en Estado de Controladores . La siguiente
ventana aparecerá 

Figure 10: Ventana Status Controladores

El Status de los controladores permite al operador revisar y verificar las condiciones del controlador y la
red. Un operador puede seleccionar un controlador o todos los controladores de la red. Toda la información
recolectada de los controladores es mostrada en esta página.
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4.9 Configuración de Red

Click en Configurar Sistema o  click en  , y luego click en Configurar Red. La siguiente ventana
aparecerá.

Figure 11: Ventana de configuración de Red

Configurar Red permite al operador configurar los parámetros de comunicaciones entre la PC (Computador
con programa de Doors  y la red de control de Acceso), configurando el puerto serial COM Port,
configurando los parámetros del MODEM o Ethernet TCP/IP (Vea la Nota de Aplicación para
comunicación LAN/WAN Ethernet - P/N 01881-001).
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4.10 Configuración de Opciones del Sistema

Click en Configurar Sistema o click en  , y luego click en Opciones del Sistema. La siguiente
ventana aparecerá.

Figure 12: Ventana Opciones del Sistema

Opciones del Sistema, permite al operador configurar los siguientes parámetros:

• Activar Sitios – Permite que múltiples sitios sean manejados por el programa Doors cuando se activa.
• Activar  Carnetización – Permite la producción  de carnets.
• Tele-Entrada – Permite la opción de EntraGuard. Sistema de tele-entrada para visitantes usando línea

telefónica
• Parámetros maestros de la Red.

− Activar Horario de Verano –Permite al controlador ajustar automáticamente la hora  cuando el
ahorro de luz de día está activo (Solo aplicable en los EEUU)

− Apertura Global – permite que las entradas de propósito general del controlador sean usadas para
dejar inmediatamente sin seguro todas las puertas en la red del sistema de control de acceso.

− Hora Segura Global- Define una hora del día cuando todas las puertas que no están bajo control
automático (por ejemplo: cuando el horario de Con/Sin seguro  es colocada a Nunca) serán
aseguradas. Confirma que todas las puertas no-controladas se aseguren por lo menos una vez al día

• Habilitar / Deshabilitar Anti Passback Local y amnistia - cuando se habilita, puede ser:
− Ninguna Amnistía permitida
− Hora del Dia - se concede la amnistía una vez al día en un tiempo  especificado (Por ejemplo,

medianoche)
− Intervalos – amnistía es otorgada periódicamente (Por ejemplo, una cada hora)
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• Tipo de Puerta
− Activar Portón - Permite que los íconos de las  puertas seleccionadas sean asignadas como

Portones.
− Activar Elevador  - Permite que los íconos de las  puertas seleccionadas sean asignadas como

Elevadores.
• Activar Pasar Lista/Rastro- Habilita la observación de las actividades del usuario de tarjeta  a través de

la ventana de monitoreo.
•  Activar Tarjeta +NIP – Habilita el uso de NIP (Número de identificación Personal) en adición a la

tarjeta de acceso cuando se usa la lectora P-650 y el controlador PXL-250W.

4.11 Configuración Grupos de Acceso

Click en Configurar Sistema o click en  , y luego click en Grupos de Acceso o directamente en

: .
 La siguiente ventana aparecerá.

Figure 13: Ventana de Configuración Grupos de Acceso

Los Grupos de Acceso permiten al operador combinar horarios y puertas en un súper conjunto de
información que es aplicado al usuario de tarjeta .  Los Grupos de Acceso definen a través de que puertas y
durante que tiempo del día un usuario de tarjeta  tiene acceso. Esto se hace usando un “Mago”, una ventana
le dará al operador un conjunto de instrucciones para, paso-a-paso, crear el Grupo de Acceso. Click en el
botón “Siguiente” para avanzar al siguiente paso.
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La ventana de selección de puertas aparecerá, permitiendo al operador seleccionar o editar las puertas que
serán asignadas a este Grupo de Acceso.  La ventana de selección de puertas mostrará TODAS las puertas
reconocidas por el sistema. Simplemente haga click sobre las puertas que se incluirán en este Grupo de
Acceso. Para seleccionar todas las  puertas tenga presionada la tecla de CTRL y haga click sobre cualquier
puerta. 

Figure 14: Ventana de Asignación de Horarios.

La ventana de asignación de Horarios  permite al operador, seleccionar (o editar) los horarios que serán
asignados a las puertas seleccionadas. Cuando toda la información ha sido ingresada, nombre y guarde el
Grupo de Acceso.
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4.12 Configuración de Tarjetas
Permite al operador enrolar tarjetas en el sistema y luego ingresar la información del usuario. Cada usuario
tiene una tarjeta que lo identifica en el sistema de control de acceso. Cuando el usuario presenta la tarjeta al
lector, requiriendo acceso, la información asociada con la tarjeta, es comparada con la base de datos del
controlador, para determinar si se le otorga acceso o no.

4.12.1 Enrolar Tarjetas

Click en  una ventana de enrolamiento aparecerá y estos dos íconos se agregarán a su barra de

herramientas  ,  haga click en  y la siguiente ventana aparecerá.

Figure 15: Enrolamiento de Tarjetas

Hay dos formas de enrolar las tarjetas:

• Enrolamiento por Bloque de tarjetas (Keri o Wiegand) por número de tarjeta- Usada cuando se tiene
una gran cantidad de tarjetas numeradas con IDs secuenciales.

• Enrolamiento por presentación de la tarjeta a la lectora – Usada cuando hay pocas tarjetas que enrolar y
si no están en orden secuencial. La lectora A del controlador maestro (01) es usada como lectora de
enrolamiento.
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NOTA: Si Ud. Está usando la lectora de proximidad y teclado P-650 Tarjeta +NIP, Ud. Deberá usar
tarjetas Wiegand de 26-bit enroladas en bloque.

4.12.1.1 Enrolamiento en bloque por rango de número de tarjeta
Para enrolar usando este método, seleccione el rango de tarjetas a ingresar en el sistema, la ventana que
aparecerá es similar a la mostrada en la Figura 15. Ingrese el número menor de tarjeta en el casillero

DESDE y el número mayor en HASTA, luego haga click en el botón  y

luego Click en  , la siguiente ventana aparecerá:

Figure 16: Guardar las tarjetas a la Lectora

Haga click en Sí para guardar a los nuevos  usuarios y por último click en .

Click en   para guardar las tarjetas enroladas.
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4.12.1.2 Enrolamiento Presentando la Tarjeta
Para enrolar usando este método , seleccione :Deseo leer tarjetas Keri , la siguiente ventana aparecerá:

Figure 17: Enrolamiento Presentando las tarjetas a la Lectora

Click en . Cuando el sistema está listo para el enrolamiento este ícono quedará
descolorido. Presente cada tarjeta, una por una, al lector  “A”  del controlador maestro (con dirección 01).
Cada vez que la tarjeta es presentada, esta es mostrada en la ventana de enrolamiento.

Cuando todas las tarjetas han sido presentadas al lector haga click en 

Click en , luego en  y se repite el
proceso anterior.
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Figure 18: Guardar las tarjetas a la Lectora

Haga click en Sí  para guardar a los nuevos  usuarios y por último click en .

Click en   para guardar las tarjetas enroladas.

4.13 Ingresando Información del Usuario de la Tarjeta

Click en  la siguiente ventana es un ejemplo de la ventana de configuración con la información que
ha sido ingresada por el operador.

Figure 19: Ventana de configuración de tarjetas – Modo Hoja de Calculos

Tarjetas pueden ser ingresadas en el modo Hoja de Cálculos (mostrado arriba) o en el Modo Cuadro de
Diálogo mostrado a continuación. Trabaje con el método que le sea más cómodo.
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Click en  para cambiar al  Modo Hoja de Cálculos. Click en  para cambiar al Modo Cuadro de
Diálogo.

Figure 20: Información de Tarjeta - Modo de Cuadro de Diálogo

Cuando la base de datos de una tarjeta a sido creada, el operador puede anular la tarjeta para prevenir que
se otorgue acceso, o anular la tarjeta y removerla de la base de datos completamente. 

En el modo de Cuadro de Diálogo, click en Datos de Usuario para mostrar la información más usual del
usuario de la tarjeta, click en Configuración Personal para activar hasta 6 campos de texto definibles, que
pueden ser aplicados a los usuarios en ambos modos (Cuadro de Dialogo y Hoja de Cálculos) 

En el modo de Hoja de Cálculos, la información del usuario de la tarjeta es ingresada directamente
escribiendo sobre la celda correspondiente (esto incluye cualquier campo habilitado en Configuración
Personal). La información de la Hoja de Cálculos  es sorteable y los comandos de selección y copia están
disponibles para copiar información repetitiva dentro de múltiples celdas. Las columnas son de tamaño
variable, permitiendo presentar la mayor información disponible.
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4.14 Configuración de Monitor
Click en Configurar Monitoreo y Eventos . La siguiente ventana aparecerá 

Figure 21: Ventana configuración de monitoreo

Los comandos de configuración de monitoreo, permiten al operador proporcionar nombres para las tres
ventanas de monitor, cual evento será mostrado en cada  ventana y cuales eventos son almacenados  en el
Registro del controlador. Click en Mensajes y aparecerá la siguiente ventana:
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Figure 22: Ventana de Configuración Textos de mensaje

Los campos de Texto de mensajes  muestran cada evento generado por el controlador . Los nombres de
eventos en los campos de mensajes, pueden ser cambiados de acuerdo a las preferencias de los usuarios.
Los botones de ON/OFF correspondiente a cada mensaje,  lo coloca en la ventana de monitoreo
seleccionada ,si esta activado (ON).Lo mismo ocurre con los eventos, solo  se almacenaran en la memoria
del controlador los activados en dicha columna (ON).
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4.15 Operando el Monitor

Click en Operar Comenzar Monitoreo o click directamente en . La siguiente ventana aparecerá.

Figure 23: Ventana de Operación de monitoreo

El comando de monitor, permite al operador  configurar hasta tres ventanas de monitoreo”en tiempo real”
(como se muestra).

Figure 24: Ventana de Monitor Vista Uno

Estas ventanas, pueden cambiar de tamaño y las tres pueden ser vistas simultáneamente, permitiendo al
operador seguir los eventos tal como ocurren en el sistema de control de Acceso.
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4.16 Sonidos de Alerta
Cuando un evento que genera un sonido de alerta ocurre, el sonido de Exclamación de Windows sonará en
la computadora repetidamente hasta que sea reconocida por el operador.

1.  Cuando un sonido de Alerta debe ser reconocido el botón de sonido  cambiará de  a  y la
ventana de exclamación será mostrada repetidamente. Para reconocer el sonido de Alerta, haga click en

 .La alarma es reconocida y el botón cambiara nuevamente a .

4.17 Operando Puertas

Click en Operar  Puertas o click directamente en  . La siguiente ventana aparecerá.

Figure 25: Ventana de Operar Puertas

Operación de puertas, permite al operador cerrar y abrir manualmente, cualquier combinación  de puertas
en el sistema de control de acceso, y realizar una completa actualización de la base de datos (Si esta es
requerida). La selección individual de puertas haciendo click en ellas o la selección de grupos de puertas
haciendo click en Clases de Puertas, y luego en el botón de operación para realizar una tarea.

NOTA: Primero debe configurar las puertas y seleccionar las clases de puertas para cada una antes de
intentar usar esta característica. Si la puerta no ha sido configurada, esta ventana puede no mostrar todas
las puertas
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4.18 Control de Salida
Click en Operar  Control de Salidas. La siguiente ventana aparecerá.

Figure 26: Ventana de Control de Salidas

El Control de las salidas, permite al operador controlar manualmente las salidas, activándolas o
desactivándolas a un simple click de botón.

NOTA:Si la tarjeta satélite es un SB293X o SB293XS, el operador puede controlar 4 salidas en vez de solo
2.

4.19 Generando Reportes de Eventos
Hay tres tipos de Reportes de Eventos: Reportes en Formatos, Reportes de Búsqueda Rápida, y Reportes de
Búsqueda  Avanzada. Para asegurarse de tener toda la información actualizada, recoja toda la información
de los eventos de los controladores antes de generar un reporte. Si usted va a recuperar alguna información
por las fechas que han estado archivadas, restaure esos archivos antes de procurar generar un informe

• Reportes en Formatos – el operador selecciona de una lista de reportes pre-programados.
• Reportes de Búsqueda Rápida- el operador selecciona los parámetros de  búsqueda de una pequeña

lista criterios comúnmente usados.
• Reportes de Búsqueda Avanzada – el operador crea una expresión de búsqueda  de una lista de

eventos, operadores boléanos, valores de eventos y enlazando operadores. Una vez creada la expresión,
puede ser guardada en una librería para futuro uso.
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4.19.1 Reportes en Formatos 
Click en Reportes  Reportes.  La siguiente ventana aparecerá.

Figure 27: Ventana de Reportes en Formatos

Reportes en Formatos han sido pre-programados para hacer más fácil al operador el ver e imprimir
información de eventos y reportes básicos del sistema. Estos reportes están divididos en dos tipos:

• Repote de eventos – Permite al operador  seleccionar un rango específico de fechas y eventos.
• Reportes de parámetros de sistemas- Permite al operador ver las configuraciones del sistema

Una vez generados, los reportes pueden ser vistos en  pantalla, impresos  en una impresora local, o
guardados como un archivo de texto en  ASCII para su almacenamiento o para su uso en otro programa
(como son los programas de Control de Asistencia).
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Reportes de Busqueda Rápida 
Click en Reportes  Eventos buscables.La siguiente ventana aparecerá.

Figure 28: Ventana Reporte búsqueda rápida

Permite al operador generar rápidamente un reporte haciendo uso de las diversas selecciones u opciones de
un conjunto de menús, seleccionando por ejemplo puertas especificas, usuarios específicos, periodos de
tiempo etc.Una vez generados los reportes pueden ser vistos en pantalla, impresos en impresora local o
guardados como un archivo de texto en ASCII para su almacenamiento o para su uso en otro programa
(como son los programas de Asistencia ).
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4.19.3 Reportes de Búsqueda Avanzada 
Click en Reportes  Eventos buscables Búsqueda avanzada. La siguiente ventana aparecerá.

Figure 27:  Ventana Reporte búsqueda avanzada

Usando el método de Búsqueda Avanzada, el operador puede usar aritmética boleana para crear plantillas
de reportes  que busquen información específica y filtrado de información innecesaria. Las plantillas
generadas con esta Búsqueda Avanzada, pueden ser guardadas y extraídas  en /de una librería (encontrada
bajo la pestaña de librería).
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4.20 Actualización Inteligente
Cuando la red de control de acceso está en operación, cualquier número de cambios menores puede ser
hecha , adicionando o removiendo usuarios de tarjetas  o cambiando parámetros de operación  de
controladores en la red. La característica de actualización inteligente, permite al operador el actualizar
todos los controladores, con solo la información que ha sido cambiada, reduciendo los tiempos de descarga.

Click en Operar Actualizar Red  o  click en  . La siguiente ventana aparecerá

Figure 30: Actualización de Red

Si cambios han sido hechos a la base de datos y la red necesita ser actualizada, el campo de actualización
requerida indicara “Si” y el marcador Skip/Update cambiara en la casilla de Actualización Inteligente
indicando “Update.”

Click en el botón de “Comenzar” para iniciar este proceso.
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4.21 Múltiples Sitios 
Doors es capaz de manejar múltiples sitios simultáneamente. Una vez habilitado (Bajo
Configurar Sistema Opciones del Sistema) una pestaña de Sitios es adicionado a la ventana de
Configurar Sistema.

Figure 31: Configuración de múltiples Sitios

La pestaña de Sitios, permite al operador ingresar la información descriptiva y la información de
configuración  para cada sitio. Una vez configurado, los usuarios de tarjetas pueden tener acceso a solo un
sitio, o a cualquiera de los sitios controlados por el operador.

4.22 Foto ID/ Carnetización
La gerenciación de carnetización y foto ID viene ya integrada en el programa de Doors. Todo lo necesario
para correr el paquete de carnetización puede ser cargado (esta es una opción de instalación) durante la
instalación del software de Doors . Una vez instalado el software de carnetización, este debe ser habilitado
para que sus comandos  aparezcan en la ventana de la Hoja de Cálculos del usuario de tarjeta.

Debe tener espacio adicional en su disco duro de la computadora para un adecuado funcionamiento del
programa de carnetización. Esto es para proporcionar espacio de almacenamiento para los archivos de
Fotos de los usuarios de tarjetas. El software de carnetización NO debe ser instalado si el disco duro del
computador no tiene los siguientes requerimientos de espacio:

• 1 a 1,000 usuarios requieren un espacio adicional de 100 MB en el disco duro.
• 1,001 a 10,000 usuarios  requieren un espacio adicional de 500 MB en el disco duro.
• Sobre 10,000 usuarios requieren un espacio adicional de 1 GB en el disco duro.

Los carnets pueden ser impresos en el modo de demostración. La palabra “Ejemplo” aparecerá en el carnet
sobre la foto del usuario como marca de agua. Para imprimir los carnets sin esta marca de agua, se debe
obtener un código de licencia de Keri Systems.
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4.22.1 Plantilla de carnet
Antes de producir los Carnets con el programa de Doors , una plantilla de carnet debe ser hecha. Una
plantilla de carnetización asocia la información del usuario de la tarjeta con las locaciones para impresión
de esa información en el carnet. La creación de esta plantilla es hecha con el programa GuardDraw
proporcionado por G&A Imaging y es incluido en Doors. El programa GuardDraw trabaja de forma similar
a la de muchos programas de dibujo y es instalado como parte de la instalación de carnetización. Después
que Ud. haya iniciado el programa de GuardDraw, click en View > Options. La siguiente ventana
aparecerá.

Figure 32: Ventana de Opciones de GuardDraw

Cerca del botón de la ventana está el campo de conexión de la base de datos “Database connection”.
Verifique que “Use the following Access97 database file option” está colocada y la ruta del folder y el
nombre del file corresponde a:  C:\Kerisys\Demo\Doors32vX.X\db\badge\Doors.mdb1

Click en el botón de OK para retornar a la ventana principal de GuardDraw 
Click en File > Print para colocar la impresora. La impresora correcta debe ser elegida antes de diseñar la
plantilla. El nombre de la impresora es escrito en los archivos de disposición, de tal manera que la
impresora que es seleccionada cuando se diseño el archivo, sea la que se use para imprimirla.

Click en File > Page Setup. Bajo el campo de “Card Setup” seleccione “CR-80 Flush Cut” para que el
tamaño coincida con la tarjeta . Click en File > New. La siguiente ventana aparecerá.

                                                          
1 X.X es el número de revisión de el Software Doors instalado.
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Figure 33: Ventana de Plantilla GuardDraw 

Usando los botones de la barra de herramientas, diseñe la tarjeta y como quiere Ud. la disposición de la
información del usuario, así como la forma en que esta información será mostrada en la tarjeta de acceso.

Guarde la plantilla, haciendo click en File > Save. Verifique que la ruta es:
C:\Kerisys\Demo\Doors32vX.X\db\badge\2

4.22.2 Habilitando Carnetización en Doors 
Los comandos de carnetización, no aparecen en la Hoja de Cálculos del usuario, hasta que esta opción es
activada haciendo Click en Configurar  Sistema Opciones del Sistema  Carnetización marque el
check.

                                                          
2 X.X es el número de revisión  de el software Doors™  instalado.
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Si ya obtuvo la Licencia de Keri Systems, entre el número en el campo de “License Code”. Si no ha
obtenido el Código de Licencia de Keri Systems, la característica de carnetización entrará automáticamente
en modo de Demostración 

Una vez habilitado la opción de carnetización  los botones de  y  aparecerán en la
ventana del Usuario de tarjeta

4.22.3 Creando Un Carnet
Una vez que la característica de carnetización  es activada, haga click en el nombre del usuario de tarjeta a

quien correponde el carnet a diseñar, luego click en . Los carnet son hechos a través de un
“Mago” que proporciona  una secuencia de pasos para el proceso de creación 
La ventana que aparecera es similar a:

Figure 34: Ventana de Información de Carnetización
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